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Standard Practices & Procedures
Introduction:
This document has been written as a guideline for standard information
technology practices and procedures for users working under System Offices.
The information provided here will be based on Office 2016, unless otherwise
noted.
Note: Press F1 at any time for Microsoft’s online help
Energy Savings:
It is recommended that computers are left on but logged off each night and
over breaks so they receive appropriate updates. Close all applications and
choose “logoff” instead of “shut down.” Machine should be at the logon screen
with no one logged on.
While it is not necessary to shut down the computer, periodically restarting it
will close any open processes, enabling a fresh reload. This helps with system
stability. There will be times when it is necessary to restart, and for those
circumstances, the IT staff will send an advance e-mail.
Please turn off all other devices including monitors, printers and other
peripherals (i.e., devices attached to your machine) each evening and during
breaks.
Logging On:
Logon to access the network from a System Offices location:
When an account is first setup, University Administration will forward the
username and temporary password to the person's University email via the
Protected Email Attachment Repository. (PEAR)
To log in to PEAR:
• Use a web browser to navigate to:
(https://appserv3.admin.uillinois.edu/pear)
• Press CTRL-ALT-DEL to get to the login screen
• Click “OK,” if necessary
• In the User Name field, type the username
• In the Password field, type the password
• The “Log On” field should say UI. (If not, click on the
dropdown menu and choose it.) If the log on field is not
visible, click on the Options >> button (Click “OK”)
AITS/UA-Urbana: 217/333-3102  AITS/UA-Chicago: 312/996-4806
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Note: If this is the first time logging into the system, a prompt to change the
password will appear
Password guidelines:
The following are requirements for valid passwords under the strong password policy:
• A password must contain at least one character from (3) of
the following (4) character classes:
• Uppercase letters (ABCDEFGHIJKLMNOPQRSTUVWXYZ)
• Lowercase letters (abcdefghijlkmnopqrstuvwxyz)
• Numbers (0123456789)
• Special characters (e.g. !@#$%^&*:?)
• The password cannot contain any four (4) consecutive
characters of your username.
• The password cannot contain any dictionary word greater
than or equal to four (4) characters.
• The password must be at least eight (8) characters long.
• The password cannot be changed to any of your three (3)
previous passwords.
• The minimum life of a password is 1 day.
• The password will expire annually.
• Do not include information about yourself, your family, your
friends, your work, your login, etc. Names, birthdays, pets,
phone numbers, license plates, addresses are all easy to locate
or guess.
• Choose a password that is not a word, place, or name that can
be found in a dictionary (even if spelled backwards.)
• Choose a password that can be typed quickly, without having to
• Look at the keyboard. Passwords like “12345,” “qwerty,”
“Aa1b2c3,” or “bbbbbbbb” are easily identified and should be
avoided
Ways to Create a Strong Password:
• Join small words (three characters or less) with a numeral or
special character ({}[],.<>;:?/|\~`!@#$%^&*()_-+=) and use
uppercase and lowercase letters. (For example:
I2caN/s3E,1t!) Note: The strength of a password is typically
increased by including special characters.
• Combine first letters from a phrase or quote that is important
to you, but be sure to include uppercase letters, lowercase
letters, and numerals. Lines from poems or songs work well.
AITS/UA-Urbana: 217/333-3102  AITS/UA-Chicago: 312/996-4806
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(For example, take the phrase “I can’t keep track of all these
dang passwords!” and turn it into “Ickt0atDp!”.) You can use
numerals for letters that resemble them, such as the number
(0) for the letter “o,” or the number “5” for the letter “s,”
although try not to do so within a full word (i.e. “cam3ra”)
• Extract vowels or consonants from words in a phrase, and mix in some
non-alphabetic characters if necessary. (For example, take the phrase
“Bond, James Bond” and turn it into “Bnd,jAm5b.” Or take the phrase
“New and Improved” and turn it into “N3w&Mprvd.”)
Changing Your Password:
•
•
•
•
•

Navigate your web browser to https://identity.uillinois.edu/
Click the “Change Password” button near the center of the page
In the “New Password” field, type the new password
In the “Confirm Password” field, type the new password
Click Set Password
Note: Five (5) incorrect attempts locks out the user
This resets automatically after five minutes
• You will be prompted to change your password after 1 year. Messages
to change your password will start to appear 14 days prior to the actual
expiration date.

Login to access network through a VPN:
(Note: If viewing e-mail only, Webmail can be used. See page 20.)
To set up VPN the first time
•
•
•
•

You MUST be connected to an Internet connection first.
In the Start Search field, type Control Panel (Windows 10.)
Click Start button, then Control Panel (Windows 7.)
Click Network and Sharing Center.

• If you see different icons, click “View By” and select “Large
Icons” or “Small Icons” to get the proper view.
• At this screen, choose “Set up a new connection or network.”
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• Then choose Connect to a workplace and click “Next”

6

• If you get a screen asking “Do you want to use a connection
that you already have?,” click “No, create a new connection”
and click “Next.”
• At this screen, click “Use my Internet connection (VPN.)”
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• At this screen, you will input the address of the VPN and name
it. Under Internet address, type “aitsras1.aits.uillinois.edu.”

7

To use the VPN connection:
• At this screen, you will input your login information.
• Next to “User name,” type your netid. (This is the username
with which you log into your computer.)
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• Input your password.
• Click the checkbox next to “Remember this password.”
• Next to “Domain (optional),” type UOFI.

• Click “Connect.”
• If everything is correct, you should see a screen that says “You
are connected.”
• The computer will save the connection. To reconnect, click on
the “Network” button in the bottom-right of the computer
screen. Then, choose the connection and click the “Connect”
button.
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Using wireless:
NOTE: For non-Planning and Administration supported buildings, contact
appropriate IT staff for using the respective wireless connection.
To request help with configuring a laptop to access the units listed below,
please contact the local IT staff.
Illinoisnet: This is available in University System Office buildings.
• Click the connection’s icon in the lower right corner.
All available wireless networks will display.
• Choose illinoisnet, select “Connect.”
• To disconnect from the wireless, click the connection’s icon in
the lower right corner. Click on illinoisnet and click
“Disconnect.”
IllinoisNet_Guest: Allows visitors with computers not in the UofI domain to
basic access to the Internet. This is available only on a limited basis.
• Left click below icon
• Connect to Illinoisnet_Guest
• Opens webpage
• Click on “Register a temporary guest account”
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Outlook:
E-mails and calendars get busier each year. The following suggestions were
developed to help staff manage Outlook functions and communications
more effectively.
• If it will be a while before you can fully respond to a sender’s e-mail, send
a quick reply letting the sender know about how long it will be before you
provide a more complete response.
• Whenever possible, respond to e-mails within 24 hours.
• If a specific action is requested of the recipient, it would be helpful to put
that action in the subject or bold it in the text. Outlook allows users to
assign send options that provide the recipients more information regarding
the e-mail’s importance. Send options include:
• Assigning an e-mail a low (use down arrow in Outlook New
Message toolbar), standard, or high priority (exclamation point in
Outlook New Message toolbar.)
• Request a reply from the recipient(s) if one is needed. To make
this setting change, open Outlook, click on “ Tools,” “Options,”
“Preferences,” “Email,” “Email Options,” “ Tracking Options,” and
select appropriate setting.
• When sending a message requesting some type of response or action, do
not address it to several people. Instead address it to the person whom
you expect to take action. If others need to receive the message, “CC”
them.
• Do not respond “Thanks” on a routine basis when you ask someone a
question and they respond. While this might seem to be the courteous
thing to do, it creates another message that people have to open, read and
delete. (A thank you is appropriate in certain circumstances, though.)
• If a message just provides information, put FYI somewhere in the subject
line, letting the recipient know that the e-mail might be less important
than other e-mails. (This is not to say that some FYI e-mails won’t have a
high priority. Use your best judgment.)
• As a personal time saver, try not to handle e-mails more than
once. This can be accomplished by placing them into
organized folders.
• Try to keep messages as short as possible. Larger messages
should be placed in memos and sent as attachments to emails.
• Send messages to specific people who require it rather than a
large group.
• Try to schedule a time to go through e-mail daily.
AITS/UA-Urbana: 217/333-3102  AITS/UA-Chicago: 312/996-4806
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Opening unknown e-mail and attachments:
To prevent infection by worms or viruses, do not open
unexpected or unknown e-mails or attachments. When in
doubt, contact:
• AITS/UA-Urbana: 217/333-3102 
• AITS/UA-Chicago: 312/996-4806
• servicedeskaits@uillinois.edu
Out of Office Assistant:
• You can set a rule with “Out of Office Assistant” or “automatic
reply” for incoming messages while out of the office.
By setting a rule there are more conditions a message must
meet. Select the one that is best for your needs. (Note: These
replies do not go outside the University.)
To set an automatic reply to incoming messages:
•
•
•
•

Open Outlook.
On the “File” tab, click on “Info,” and select “Automatic Replies.”
Click “Send Automatic Replies.”
Inside the “Inside My Organization” and “Outside My Organization”
tabs, customize your out of office messages.
• Click “OK.”

To create a rule with Out of Office Assistant:
• Open Outlook.
• On the “File” tab, click on “Info,” and select “Manage Rules
and Alerts.”
• Click “New Rule.”
• Follow the wizard to create the desired rule.
• Click “Finish” when completed.
Inbox folders:
• University System Offices does not support personal folders. However,
subfolders can be created under the Inbox folder. (If .pst files have been
created, drag and drop them to this new location.)
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To create new subfolders:
• Open Outlook.
• On the “Home” tab, right click on the folder where you want the subfolder,
and select “New Folder.”
• Type the name of the new folder under “Name.”
• Make sure the folder is being created where you want, and click “OK.”
Public folders:

• Public folders can be viewed by all University System staff. To add a folder
to this area, contact EOIT (for EO) or AITS Security (for AITS/UA) by e-mail
to Outlook Requests.
• To move an item to a public folder:
• Open Outlook.
• On the “Home” tab, right click on “Item,” select
“Move,” and choose the appropriate folder.
Reserving a resource:
Reserving a resource is made easy in Outlook. Examples of resources
include: projectors, laptops, vehicles, and conference rooms.
Reserving a resource electronically allows you to save time by having to call or track down
equipment.
• Open Outlook.
• In the “Home” tab, click on the “Calendar” shortcut.
• Select “New Appointment,” and select “Invite Attendees” (the “TO” button
will pop up.)
• Click on the “TO” button, and select the appropriate resource. (See
explanation above.)
• Click on “Resources,” and “OK.” Multiple resources can be set up here at
one time.
• Fill out the rest of the appointment form, and click “Scheduling.” (This is
located on the ribbon at the top of the screen.)
• This screen will show when the resource is free or busy.
• Once a date and time has been chosen, click “Send.”
• The owner of the resource will either accept or deny the request.
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Scheduling a meeting:
Scheduling a meeting is made easy in Outlook. By scheduling a meeting electronically,
time is saved by not having to make multiple calls to check availability.
•
•
•
•
•

Open Outlook.
In the “Home” tab, click on the “Calendar” shortcut.
Select “New Meeting.”
Click on the “TO” button, select the participant(s), and click on “Required.”
Fill out the rest of the appointment form, and click “Scheduling Assistant”
near the top of the window. This screen will show when the participants
are free or busy.
• Once a date and time has been chosen, click “Send.”
• The participants will either accept or deny the request.

Setting free/busy options:
This is where the months of your calendar are published so that others can view your
free/busy status when they are scheduling meetings. By default, Outlook displays 2
months. You can expand that period of time by:
•
•
•
•
•
•

Open “Outlook.”
On the “File” tab, select “Options” and “Calendar.”
Under “Calendar Options,” select “Free/Busy Options.”
Under the “Permissions” tab, select “Other Free/Busy.”
Change the number field to how many months you want to show.
Click “OK” three (3) times to exit out.

Sharing calendars:
You must set up a calendar for sharing before sharing it.
(By default it is not shared.)
•
•
•
•
•

In “Calendar View” in Outlook, click on the “Share Calendar” button.
A blank e-mail opens.
Select who to share your calendar with and place in the “TO” field.
Send like regular e-mail.
Note: A checkmark can also be placed in the box requesting permission to
view recipient’s calendar.
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Opening a Shared Calendar:
• In “Calendar View” in Outlook, click on the “Open Calendar” button, then
choose “Open Shared Calendar.”
• Click on the “Name” button to choose whose calendar to view.
• Click “OK.”
Sharing contacts:
In order to share contacts in Outlook they must be setup to be shared.
• In Contacts view in Outlook, click on the Share Contacts button. A blank
e-mail will open.
• Select who to share contacts with and place in the “TO” field. Send like
regular e-mail.
• Note: A checkmark can also be placed in the box requesting permission to
view recipient’s contacts.
Sharing folders:
You must set up a folder for sharing before sharing it. Personal folders can
only be shared if they are under the Inbox folder in Outlook.
• In Mail view in Outlook, right click on the folder to share.
• Click on “Properties.”
• A dialog box will open. Under the “Permissions” tab, click on the “Add”
button, select the user(s) to share folder with, and click “OK.”
• With the user(s) name highlighted, choose the permission level being given
(click on dropdown menu for options.) Note: For an explanation on the
permission levels, see “Help” in Outlook.
• Do this for each user added.
• Click “OK” when complete.
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To access a shared folder:
• In Outlook, click on the “Folder List” button (at the bottom-left, shaped a
folder.) This will show all available folders
Adding mailbox to Outlook profile:
•
•
•
•

Open Outlook.
Under the “File” tab, choose “Account Settings,” then “Account Settings.”
Click on “Change,” and “More Settings.”
On the “Advanced” tab, add additional mailbox(es.) Click on the “Add”
button and put in the name of the Outlook mailbox to add.
• Select “OK” until back at the main Outlook window.

Using Webmail:
•
•
•
•

Select “OK” until back at the main Outlook window.
In a web browser, type https://webmail.illinois.edu.
Type in your “NetID” and password.
Click “Log On.”

Internet:
•
•
•
•

Do NOT install updates that have not been approved by IT staff.
Tips on how to search for information on the web:
Google Tips (see Appendix A.)
Standard browser:
(The standard browser for use is Internet Explorer.)
• Pop-ups:
Instead of choosing “X” to close pop-up windows, press Alt F4.

Saving Files:
Salvaging documents (EO offices only): Using the Volume Shadow Copy &
Previous Version Client.
Snapshots of data that has changed are stored every hour starting at 7 a.m. and
ending at 5 p.m. from Monday through Friday. If there are files that have not
changed for some time, then there will be no previous version available for
individual files. If a file has been created or had changes made recently, this will
be useful.
AITS/UA-Urbana: 217/333-3102  AITS/UA-Chicago: 312/996-4806
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To restore a deleted folder or file:
• Right click on “Start,” choose Open Windows Explore, right-click the
network drive in the left panel, and choose “Restore Previous Versions.”
• Select one of the folders from the list provided.
• Click on “Open.”
• Find the document or file that was deleted. Copy and paste it back into the
drive that is open in Explorer.
To restore an earlier version of document:
• Right click on “Start,” choose “Open Windows Explore,” right-click the
network drive in the left panel, and choose “Restore Previous Versions.”
• Right click on “Start,” choose “Explore,” locate the network drive, and open
the directory the document is located in.
• Move cursor to the right pane of “Explore,” find the document, highlight it,
and right-click.
• Choose “Properties” and click on the “Previous Version” tab.
• Earlier versions of this document will be shown. Choose either “View,”
“Copy,” or “Restore” to overwrite the one that needs to be replaced.
• Note: If the network profile is setup to use folder redirection, restore
previous versions from “My Documents” can be used.
Where to save files:
• Departments should have a file structure setup on their network drive for
shared directories.
• Each user also has a home directory where files can be stored that are not
being shared.
• For AITS/System Offices users: To safeguard files, it is recommended to
save them to the home or shared directories, as this information is backed
up regularly and can be restored after a disk failure.
There is the ability to setup Microsoft Office programs to save documents to particular
areas by default. To do this:
• Open the program (i.e. Word), click on “File,” choose “Options,” “Save.”
• In “Default File Location,” click the “Browse” button to change location.
• Click “OK” when complete.
AITS/UA-Urbana: 217/333-3102  AITS/UA-Chicago: 312/996-4806
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Encryption:
(AITS/System Offices only): Staff using a laptop or home machine
(either personal or University provided) that accesses and stores
University of Illinois data are required to deploy file encryption. This
provides assurance that sensitive data remains protected in the event
of loss of control of the device.
What is sensitive data?
• Social Security numbers
• UIN
• State issued ID or driver’s license number
• Health information in combination with any personal identifier.
• Passwords, salary information, general ledger information.
Encryption Procedure:
• Right click on the folder or file to encrypt, select “Properties.”
Note: It is recommended that the entire folder is encrypted.
• Select the “General” tab, and click on “Advanced.”
• Put a checkmark in the Encrypt contents to secure data.
• Checkmark the top (2) boxes.
• Click “OK.”
• Return to the “General” tab, and click “OK.”
• A “Confirm Attributes Changes” box will popup. Make sure that “Apply
Changes to this folder, subfolders, and files” is checked, and click “OK.”
• If an “Error Applying Attributes” message is received, click on “Ignore all.”
Files may be unencrypted, in case of problems, by repeating this procedure
and unchecking the Encrypt contacts to secure data box.
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Mapping a drive: (Windows 10 procedure)
• Double click on the “This PC” icon on the desktop.
• Select “Computer,” and “Map network drive” (on top toolbar.)
• When the “Map Network Drive” dialog box appears, choose a drive. (Z: is
fine.)
• In the “Folder” field, type \\[file path name]. (Get this from the IT unit.)
• Check “Reconnect at logon” if needed.
• Click Finish.
• Use Explorer to browse to this drive.
Mapping a drive: (Windows 7 procedure)
• Click on the Windows button, “Computer, and Map Network Drive”
(on top toolbar.)
• When the “Map Network Drive” dialog box appears, choose a drive. (Z:
is fine.)
• In the “Folder” field, type \\[file path name] (Get this from the IT
unit.)
• Check “Reconnect at logon” if needed.
• Click “Finish.”
• Use Explorer to browse to this drive to see documents.
Creating shortcuts:
•
•
•
•
•

Click on the “Windows” button and “All Programs.”
Right click on program that a shortcut is needed for.
Choose “Send to desktop” (create shortcut.)
For Windows 10, from the “most used menu” drag the app to the desktop
Repeat as needed.

Creating PDF documents: (From Office 2016)
• Click on the “File” tab, choose “Save as Adobe PDF,” then choose “PDF” in
the save as type drop down box. (Note: A PDF saved here cannot be
converted to another file type by using Adobe Professional.)
• Click on the “File” tab and select “Print,” when the print dialog box opens,
choose “Adobe PDF” from the drop down menu, and click “OK.”
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CD Storage:
How to burn CDs: (Windows 7 & and 10 have built-in ability to write to
a CD without additional software.
• Insert a blank CD into the computer.
• In the Explorer view, drag and drop (or copy and paste) the files to the
blank CD drive
• Right click on the drive and select the option to write files to the CD.
• The CD will eject when complete.
Supported copying software:
• The software that is supported is the software that came with the machine
(i.e. Roxio.)
Digital Photos:
Digital camera settings:
With so many different digital cameras available, it is not possible to state the
right settings for all. The use of the photo will determine the camera setting.
Users must refer to their camera’s handbook. (By default, most cameras are
set at the highest resolution.)
Storing photos:
Be careful not to store duplicates of photos. This takes up a lot of room on
the network. If photos are no longer being used, burn them to a CD and
remove them from the network. Personal photos should not be stored on
the network.
PC Maintenance:
Deleting temporary and Internet files:
One really easy way to free up some disk space in Windows is to delete
temporary files, sometimes referred to as temp files.
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Temporary Files:
• Click on the Windows button, at the Start Search type %tmp%, and click
enter.
• A “Temp” dialog box will open. The entire contents of this folder can be
deleted. Select “Edit,” select “All” (the documents will now be highlighted),
press “Delete the Selected Items,” “Yes.” Sometimes a message will be
received stating a file cannot be deleted for one reason or another, which
is ok, just highlight the files below that one and press “Delete” again.
Temporary Internet Files (Internet Explorer 11)
• Open Internet Explorer.
• Select “Tools,” click Delete Browsing History.
• ( Choose what to delete or select Delete)
Rebooting computer:
Rebooting is always a great idea to allow the
computer to reset. Many times this will correct a
problem without any further troubleshooting.
Removal of University software:
DO NOT do this unless instructed to do so by IT staff.
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Virus scan:
Virus scanning software is critical to protecting the environment from
potential threats. The software automatically performs virus detection and
removal tasks for specific viruses. If a computer system is infected, the tools
will remove the virus and repair any damage.
The software adopted by the Planning and Administration units is System
Center Endpoint Protection. It offers easily scalable protection, fast
performance, and mobile design to protect the environment from viruses,
worms, Trojan horses, as well as potentially unwanted code and programs.
The following is a description of the major components and the schedule for
running them as determined by Planning and Administration.
Auto-updates: (VS8 Update)
Automatic updates have been configured of detection definitions, scanning
engine, and product upgrades.
(The schedule is set for every 2 hours.)
On-Demand Scan:
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The full systems scan provides a method for scanning all parts of the
computer for potential threats at regular intervals. It scans all local drives,
memory and processes, and cleans, deletes or quarantines them upon
detection. The use of full system scans supplements the continuous
protection that the on-access scanner offers.
(The scan is scheduled for Wednesday’s at 3:05 AM.)
On-Access Protection rules:
This feature continually detects potential threats that arrive on disks, from
the network, or from various sources on the Internet. This option is always
enabled.
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Recommendations for using On Access Protection:
Leave computer on Tuesday evening (computer should always be left on,
so the full system scan can take place. (See Energy Savings) If this does not
occur at the scheduled time, the next time the computer is started, a slow
response time will be experienced as it attempts to run the full scan of the
machine.
Users with personal home equipment are required to have virus scanning
software that is current before attempting to connect to network
resources. Antivirus software is available free from the campus web
store. Logon to see the current version that is available.
• UIC ACCC: http://www.uic.edu/depts/accc/software/software.html
• UIUC TECHNOLOGY SERVICES: http://webstore.uiuc.edu/
Printing:
Adding printers: Network printers are quickly setup on the workstation using
the following procedure:
• Click on the Windows button.
• In the “Start Search” field, type in \\CHIPRINT2, select “Enter.”
• A window will appear showing all the resources available from the server.
Right click and choose “Connect” on the appropriate printer OR double
click on the appropriate printer.
• It will now be in the printer choices.
Setting a default printer: (Windows 10)
• In the “Start Search” field, type “Devices and Printers,” select “Enter.”
• Right click on the printer to be the default, select “Set as Default”
from the drop down list.
Setting a default printer: (Windows 7)
• Click on the Windows button, select “Devices and Printers.”
• Right-click on the printer to be the default, select “Set as Default”
from the drop down
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Purchasing Hardware and Software:
Please consult with someone from the appropriate System IT office before
proceeding to purchase computers, related office equipment, or software
for use in the office. This will help ensure that items have been chosen will
be the most compatible with the environment, thereby increasing
productivity. This also allows standardization of equipment, which helps us
improve the quality of support provided. Please do not hesitate to contact
the IT staff for assistance in choosing software, computers, printers,
scanners, networked copiers, or other equipment or peripherals connecting
to computers or the network.
Smartphones:
Apple iPhone:
•
•
•
•
•
•
•

Click on “Settings” and choose “Mail,” “Contacts,” “Calendars”
Click “Add Account” and choose “Microsoft Exchange”
Under “Email,” type <yournetid>@illinois.edu
Under “Domain,” type “uofi”
Under “Username and Password,” type <yournetid> and password
Under “Description,” put an account name and click “Next”
Under “Server,” type exchws.illinois.edu and click “Next”

•
•
•
•
•
•
•
•
•
•
•

Select “Home”
Select “Menu”
Choose “Settings,” “Accounts.”
Add “Account”
Choose “Corporate Sync”
Type in UOFI\ your netID, and NetID password. Type in your email address
Type in server name, exchws.illinois.edu
Select “Next”
Choose “Calendar, Contacts, Email”
Make sure “SSL” is checked
“Finish”

Droid:
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Bluetooth:
Bluetooth wireless technology is a short-range communications system
intended to replace the cables connecting portable and/or fixed electronic
devices.
•
•
•
•

Go to “My Bluetooth Places.”
Select “View Devices in Range.”
After the discovery process is complete, choose the appropriate icon.
Right-click on the icon, and select “Discover Available Services.”
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APPENDIX A
Tips for Google Searches on the Internet
Find similar terms.
• Insert the tilde (~) in front of a search item, Google will retrieve sources
matching the word as well as synonyms. Do not leave a space between the
tilde and the search item. (Example: “~zoo” will yield the Animal Planet, Zoos,
National Wildlife Federation.)
Exclude terms.
• By using the hyphen you will eliminate many irrelevant sites. (Example:
“plasma-TV” or “plasma-TV-television.”) You do not need to use the word
“and.”
Substitute for unknown words.
• Use asterisks to stand in for missing words. (Ex. “Four * and * Years Ago”)
Find lost pages.
• The cache option in Google will retrieve the last saved version of the page.
This tool is helpful when you come across old pages from web sites that no
longer exist or are no longer maintained. The cache link is found at the bottom
line of the search result.
Get the name.
• If you have the phone number but want the name and/or location, type in
the number. Do not include hyphens, parentheses or spaces. (What you are
looking for may not be on the top of the list provided by Google.)
Look up synonyms.
• Type “define: and your search word.”
(Example: “define: legislation”)
Explore specific sites.
• Restrict your search solely to a specific site by using the site keyword.
(Example: “the pc guy site:northjersey.com.”)
Get the picture.
• Go to the Google home page and click on images. You can narrow your
searches using the advanced function and retrieve certain types or sizes of
files.
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APPENDIX B Other
Help Resources
University of Illinois at Chicago (ACCC)
consult@uic.edu
312/413-0003
University of Illinois at Springfield (ITS)
techsupport@uis.edu
217/2066000
217/206-8324
877/847-0443
University of Illinois at Urbana-Champaign (Technology Services)
consult@illinois.edu
217/244-7000
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